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NI PXI-5404 CaLiBrRATION PROCEDURE

This document contains step-by-step instructions for writing a calibration
procedure for the NI PXI-5404 100 MHz Frequency Source.
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Conventions

»

%
5

bold
italic

monospace

The following conventions are used in this manual:

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.
This icon denotes a note, which alerts you to important information.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names.

Ttalic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

Calibration Overview

This section describes external calibration and explains why and how often
you should calibrate your modules.

What Is External Calibration?

External calibration is a set of operations that compares the signals
generated by a module or a system to external standards. The result of an
external calibration can be used to determine the output error and can be
used to correct the errors in the adjustment process.

The calibration process consists of verification, adjustment, and
reverification. During verification, you compare the measured performance
to an external standard of known measurement uncertainty to confirm that
the performance of the module is better than the published specifications.
During adjustment, you correct the generation error of the module by
adjusting the calibration constants and storing the new calibration constants
in the onboard EEPROM. The host computer reads the calibration
constants and the software uses them to compensate for errors and to
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present a calibrated output to the user. Reverification means repeating
verification after the adjustment process.

Why Should You Calibrate?

The accuracy of electronic components drifts with time and temperature,
which can affect generation accuracy. Calibration restores the NI 5404 to
its specified accuracy and ensures that it still meets National Instruments
standards.

How Often Should You Calibrate?

NI recommends performing a complete calibration at least once every year.
You can shorten this interval based on the demands of your application.

Equipment and Other Test Requirements

This section describes the test equipment, test conditions, documentation,
and software required for calibration.

Test Equipment

External calibration requires different equipment for each applicable
specification. Refer to Table 1 for a list of equipment.

Table 1. Equipment Required for Calibrating NI 5404 Modules

Applicable Minimum Recommended
Instrument Specification Specifications Instrument
Digital multimeter SINE out amplitude AC amplitude accuracy | NI PXI-4070
(DMM) accuracy better than £0.5% at Agilent (HP)
50 kHz at 4 Vpk-pk 34401A
Keithley 2000
Male banana to — —
female BNC adapter
Male BNC to 50 Q —
female SMB cable
Spectrum analyzer Frequency accuracy Bandwidth >150 MHz NI PXI-5660
Frequency accuracy to
+500 ppb
Male SMA to — —
female SMB cable
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Table 1. Equipment Required for Calibrating NI 5404 Modules (Continued)

Applicable Minimum Recommended
Instrument Specification Specifications Instrument
Oscilloscope CLOCK out Bandwidth 2500 MHz Tektronix
duty cycle accuracy TDS3054
Male BNC to — —
female SMB cable
Power meter and SINE out amplitude +0.15 dB accuracy for Rohde &
thermal power sensor passband flatness flatness measurements Schwarz NRVS
from 9 kHz to 105 MHz | meter
Rohde &
Schwarz
NRV-Z51 or
Rohde &
Schwarz
NRV-Z53 sensor
Female N-Type to 50 Q —
female SMB cable

Test Conditions

Documentation
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Follow these guidelines to optimize the connections and the environment
during calibration:

*  Keep connections to the NI 5404 module short.
e Keep relative humidity below 80%.

*  Maintain a temperature between 18 and 28 °C.

For information on installing NI 5404 modules, you may find the following
documents helpful:

* NI Sources Getting Started Guide
* NI Sources Help
e Specifications for NI PXI-5404

The NI Sources Help includes detailed information on the NI-FGEN
instrument driver functions. You can access this help file by selecting
Start»Programs»National Instruments»NI-FGEN»NI Sources Help.
The NI Sources Getting Started Guide provides instructions for installing
and configuring NI source modules.

For the latest versions of NI manuals, refer to ni . com/manuals.
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Software

This section describes the software you need to calibrate the NI 5404
module.

Writing Your Calibration Procedure

The calibration process is described in the External Adjustment section,
including step-by-step instructions on calling the appropriate calibration
functions.

Many of the calibration functions use constants defined intheniArbcal.h
file. To use these constants, you must include niArbcCal.h in your code.
Refer to Table 2 for file locations.

Calibration Software

The calibration procedure requires the latest version of NI-FGEN on the
computer system that is controlling the NI 5404. NI-FGEN configures and
controls NI 5404 modules. NI-FGEN ships with the NI 5404. You can also
download NI-FGEN from ni.com/softlib.nsf. NI-FGEN supports
programming of all NI signal sources using a number of languages,
including LabVIEW, LabWindows™/CVI"™, Microsoft Visual C++,

and Microsoft Visual Basic. When you install NI-FGEN, you only need to
install support for the programming language that you intend to use.

Although NI-FGEN includes calibration support, the calibration
application programming interface (API) is separate from NI-FGEN.
During verification and adjustment, you use two APIs: the NI-FGEN API
and the NI 54XX API. The NI-FGEN API controls the module both during
normal operation and during the verification procedure. The NI 54XX API
controls the module during the adjustment procedure.
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NI-FGEN automatically installs the files listed in Table 2.

Table 2. Calibration File Locations

File Name and Location

Description

<system directory>\niArbCal.dll

The NI 54XX calibration toolkit

library. This toolkit provides the
functionality for calibrating your
module.

VXIpnp\WinNT (Win95) \lib\msc\niArbCal.lib
VXIpnp\WinNT (Win95) \1lib\bc\niArbCal.lib

A .1ib file that allows you to create
applications that call functions in the
niArbCal.dll:

e If you build an application using
Microsoft Visual C/C++, link to
msc\niArbCal.lib

e If you build an application using
Borland C/C++, link to
bc\niArbCal.lib

e If you build an application using
LabWindows/CV], link to the
library appropriate to your current
compatibility mode (msc for
Microsoft Visual C/C++, be for
Borland)

VXIpnp\WinNT (Win95) \include\niArbcCal.

A header file for the accessible
functions in the niArbcal.dll.
You must include this file in any
C code that you write to call these
functions.

VXIpnp\WinNT (Win95) \nifgen\Examples\
Calibration)\
ExternalCalibrationExample5404.c

Example written in C that illustrates a
calibration procedure using the
functions in the niArbcal.dll.

VXIpnp\WinNT (Win95) \nifgen\Examples\
Calibration\VisualBasic\
SimpleCalibrationExample.vbp

VXIpnp\WinNT (Win95) \nifgen\Examples\
Calibration\VisualBasic)\
SimpleCalibrationExample.vbw

VXIpnp\WinNT (Win95) \nifgen\Examples\
Calibration\VisualBasic\
SimpleCalibrationExample. frm

Example written in Visual Basic
that illustrates using the functions in
the niArbcal.dll.

NI PXI-5404 Calibration Procedure
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Table 2. Calibration File Locations (Continued)

File Name and Location Description
LabVIEW 6 (6.1)\instr.lib\niHSSources\ This LabVIEW LLB contains VIs that
niHSSources_Calibration) correspond to the functions in the
niHSSources Cal.llb niArbCal.dll.
LabVIEW 6 (6.1)\instr.lib\niHSSources\ This LabVIEW LLB contains VIs that
niHSSources_Calibration)\ demonstrate an external adjustment
niHSSources Cal 5404 External Calibration procedure using the VIs in
Example.llb niHSSources_Cal.llb.

Calibration Procedures in C

To write calibration procedures in C, you must include the niArbcCal.h
file in the code that calls the calibration functions, and you must link the
niArbCal.1lib file into the build of your executable.

Calibration Procedures in LabVIEW

To write calibration procedures in LabVIEW, you must use the VIs
included in the niHSSources_Cal.11lb. This library contains a VI for
each function exported by the niArbcal.dll, as well as other useful
functions. After installation, all of these VIs appear within the NI HS
(High-Speed) Sources Calibration palette under Functions»Instrument
I/O»Instrument Drivers»NI High-Speed Sources»NI HS Sources
Calibration. The NI HS Sources Calibration palette also contains example
VIs that illustrate how to use the calibration functions.

Calibration Procedures in Visual Basic

To write calibration procedures in Visual Basic, complete the following
steps:

1. Configure the project to reference the niArbCal.dl1 by selecting
Project»References from the menu bar.

2. Click Browse and navigate to your system directory.
3. Find and select niArbCal.dll.

4. Click Open.

5. Click OK.

You can then use the niArbcCal functions in your code and look up the
functions, parameters, and constants in the Object Browser.
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Verification

This section provides step-by-step instructions for verifying the NI 5404
specifications. Verification determines whether the module is performing
within its specifications prior to adjustment. Verification and adjustment
together comprise a complete calibration. To verify that the NI 5404 still
meets its specifications, you must use NI-FGEN to control the NI 5404
module. The following steps describe the code you use to generate the
appropriate signals, as well as the NI-FGEN function calls you make to
verify specifications. The code varies depending on which API you use:
LabVIEW, LabWindows/CV], or Visual Basic. The examples shown in
this section use LabWindows/CVI code, but LabVIEW has a
corresponding VI for each function.

You can verify the following specifications for NI 5404 modules:
e SINE out amplitude accuracy

e Frequency accuracy

e CLOCK out duty cycle accuracy

*  SINE out amplitude passband flatness

Refer to Table 1 for information concerning which instrument to use for
each characteristic.

The verification procedure for each of these specifications includes setting
up, programming, and cleaning up.

NI PXI-5404 Calibration Procedure 8 ni.com



Figure 1 shows the NI 5404 connectors.
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Figure 1. NI 5404 I/0 Connectors

Verifying Frequency Accuracy

Use the spectrum analyzer specified in Table 1 to measure the frequency
accuracy of the NI 5404 module. Connect the SINE out of the NI 5404 to
the input of the spectrum analyzer using an SMB to SMA cable.

Generate a 10 MHz frequency using the NI 5404 module by completing the
following steps:

1. CallniFgen init () to initialize the module you are testing and to
create an I/O session. Set the following parameters:

» vi—The output that is passed in by reference to the verification
functions as sessionHandle

e resourceName—"DAQ: : #”, where # is the device number

© National Instruments Corporation 9 NI PXI-5404 Calibration Procedure




¢ ID Query—True
¢ Reset Device—True

Call niFgen ConfigureStandardWaveform() to select the
channel to output a waveform. Set the following parameters:

e vi—The output value sessionHandle you obtained from the
niFgen init function

¢ Channel_Name—" 0"

e Amplitude—2

*  Frequency—10000000

e Start phase—o0

*  DC offset—o

e Waveform—NIFGEN VAL WFM_SINE

CallniFgen InitiateGeneration() to initiate signal generation.
This function causes the NI 5404 to leave its configuration state and
enter its signal generation state. Set the following parameter:

e vi—The output value sessionHandle you obtained from the
niFgen init function

Measure the frequency of the SINE output using a spectrum analyzer
specified in Table 1. To determine if the measured frequency is within
the specification of the NI 5404, you must determine the measurement
error of the instrument that you used to measure the frequency and
account for this error when comparing the measured frequency to the
frequency accuracy listed in the Specifications for the NI PXI-5404.

Call niFgen close () to close the module I/O session, destroy the
instrument driver session and all of its properties, and release any
memory resources the driver uses. Set the following parameter:

e vi—The output value sessionHandle you obtained from the
niFgen init function

You have completed verifying the module oscillator frequency accuracy of
the NI 5404.

Verifying SINE Out Amplitude Accuracy

Use a DMM specified in Table 1 to measure the SINE out amplitude
accuracy of the NI 5404. Connect the SINE out of the NI 5404 to the input
of the DMM using the male banana to female BNC adapter and the BNC to
SMB cable.

@ Note A 50 Q terminator is not used for this measurement.

NI PXI-5404 Calibration Procedure
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Generate a 4 V. px (into high impedance) 50 kHz sine wave as follows:

1.

Call niFgen init () to initialize the module you are testing and to
create an I/O session. Set the following parameters:

* vi—The output that is passed in by reference to the verification
functions as sessionHandle

¢ resourceName—"DAQ: : #”, where # is the device number
* ID Query—True
¢ Reset Device—True

Call niFgen ConfigureStandardWaveform() to select the
channel to output a waveform. Set the following parameters:

* vi—The output value sessionHandle you obtained from the
niFgen init function

¢  Channel_ Name—" 0"

*  Amplitude—2

*  Frequency—50000

e Start phase—o0

*  DC offset—o

*  Waveform—NIFGEN VAL WFM_SINE

CallniFgen InitiateGeneration () to initiate signal generation.
This function causes the NI 5404 to leave its configuration state and
enter its signal generation state. Set the following parameter:

*  vi—The output value sessionHandle you obtained from the
niFgen_ init function

Measure the rms voltage of the SINE output using a DMM specified in
Table 1. To determine if the measured voltage is within the amplitude
accuracy specification of the NI 5404, you must determine the
measurement error of the DMM that you used to measure the rms
voltage and account for this error when comparing the measured
voltage to the amplitude accuracy listed in the Specifications for the
NI PXI-5404.

@ Note A 4 V. sine wave has an rms amplitude of 1.41421 V.

S.

Call niFgen close () to close the module I/O session, destroy the
instrument driver session and all of its properties, and release any
memory resources the driver uses. Set the following parameter:

*  vi—The output value sessionHandle you obtained from the
niFgen_init function

You have completed verifying the SINE out amplitude accuracy of the
NI 5404.

© National Instruments Corporation
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Verifying SINE Out Amplitude Passhand Flatness

The following procedure measures SINE out amplitude over several
frequencies to verify that the SINE out amplitude passband flatness meets
NI 5404 specifications.

Complete the following steps to verify SINE out amplitude passband
flatness:

1.

Call niFgen init () to initialize the module you are testing and to
create the I/O session. Set the following parameters:

*  vi—The output that is passed in by reference to the verification
functions as sessionHandle

e resourceName—"DAQ: : #”, where # is the device number
¢ ID Query—True
¢ Reset Device—True

Call niFgen ConfigureStandardWaveform() to configure the
sine wave. Set the following parameters:

e vi—The output that is passed in by reference to the verification
functions as sessionHandle

¢ Channel_Name—"0"

*  Amplitude—2

e Start phase—o0

¢ Frequency—50000

¢ DC offset—o

¢ Waveform—NIFGEN VAL WFM SINE

Call niFgen InitiateGeneration (). This function causes the
NI 5404 to leave its configuration state and enter its signal generation
state. Set the following parameter:

e vi—The output value sessionHandle you obtained from the
niFgen init function

Measure the SINE out amplitude using a DMM specified in Table 1.

@ Note The 50 kHz amplitude accuracy of the DMM is better than the 50 kHz amplitude
accuracy of the power meter. To get the best passband flatness results, you either must
calibrate the power meter or use the power meter to make amplitude measurements, at
frequency indices 0—11, which are relative to the absolute amplitude measurement made
by the DMM at frequency index 0. The latter choice is preferred.

NI PXI-5404 Calibration Procedure
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To measure the SINE out amplitude passband flatness using the power
meter, complete the following steps:

a.

Measure the 50 kHz amplitude using the AC rms (dBm) function
of the DMM. Do not use a 50 Q terminator when using the DMM.

Subtract 6 dBm from the DMM measurement, because the power
meter has a 50 Q input impedance. The result of the subtraction is
the power level of the 50 kHz SINE out into a 50 Q load.

Measure the 50 kHz amplitude with the power meter and compare
the power result to the DMM result. If the power meter result is
higher than the DMM result, subtract the difference of the two
results (in dBm) from the power meter results for frequency
indices 0—11. If the power meter result is lower than the DMM
result, add the difference of the two results (in dBm) to the power
meter results for frequency indices 0—11.

Disconnect the SINE out of the NI 5404 from the DMM and connect
SINE out to the power meter using the SMB to N-Type cable

Repeat the following steps for each frequency in Table 3:

a.

Call niFgen ConfigureStandardWaveform() to configure
the sine wave. Set the following parameters:

* vi—The output value sessionHandle you obtained from
the niFgen init function

¢  Channel_Name—" 0"

*  Amplitude—2

e Start phase—o

*  DC offset—o

*  Frequency—The current frequency from Table 3
*  Waveform—NIFGEN VAL WFM SINE

Measure the SINE out amplitude using a power meter specified
in Table 1. To determine if the measured amplitude is within

the specification of the NI 5404, you must determine the
measurement error of the instrument that you used to measure the
amplitude. You must account for this error when comparing the
measured amplitude to the amplitude passband flatness accuracy
listed in the Specifications for NI PXI-5404.
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Table 3. Frequencies for Verifying SINE Out Amplitude Passband Flatness

Index Frequency (MHz)

0 1

1 15
2 30
3 45
4 60
5 75
6 88
7 92
8 96
9 99
10 102
11 104

7. CallniFgen close (). Set the following parameter:

vi—The output value sessionHandle you obtained from the
niFgen init function

You have completed verifying the SINE out amplitude passband flatness of
your module.

Verifying CLOCK Out Duty Cycle Accuracy

Complete the following steps to measure the duty cycle of the NI 5404
when you use it to generate a 50% duty cycle:

1. CallniFgen init () to initialize the module you are testing and to
create an I/O session. Set the following parameters:

NI PXI-5404 Calibration Procedure

vi—The output that is passed in by reference to the verification
functions as sessionHandle

resourceName—"DAQ: : #”, where # is the device number
ID Query—True

Reset Device—True
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2. CallniFgen ConfigureStandardWaveform() to select the
channel to output a waveform. Set the following parameters:

* vi—The output value sessionHandle you obtained from the
niFgen init function

¢  Channel_Name—" 0"

*  Amplitude—s5

*  Frequency—1000000

*  Waveform—NIFGEN VAL WFM_SQUARE
e Start phase—o

*  DC offset—o

3. CallniFgen SetAttributeViRealé4 (). Set the following
parameters:

*  vi—The output value sessionHandle you obtained from the
niFgen_ init function

*  Channel Name—" 0"
e Attribute_ID—NIFGEN ATTR FUNC DUTY CYCLE HIGH

e Value—50.0

@ Note If you are using LabVIEW, select the property node attribute niFgen»Standard
Function Output»Duty Cycle High.

4. CallniFgen InitiateGeneration () to initiate signal generation.
This function causes the NI 5404 to leave its configuration state and
enter its signal generation state. Set the following parameter:

*  vi—The output value sessionHandle you obtained from the
niFgen_ init function

5. Measure the duty cycle of the CLOCK output using an oscilloscope
specified in Table 1. To determine if the measured duty cycle is within
the specification of the NI 5404, you must determine the measurement
error of the oscilloscope that you used to measure the duty cycle and
account for this error when comparing the measured duty cycle to the
duty cycle accuracy listed in the Specifications for the NI PXI-5404.

6. Call niFgen ConfigureStandardWaveform() to select the
channel to output a waveform. Set the following parameters:

*  vi—The output value sessionHandle you obtained from the
niFgen_init function

¢  Channel_Name—" 0"
*  Amplitude—s5

*  Frequency—25000000
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e Waveform—NIFGEN VAL WFM SQUARE
e Start phase—o0
*  DC offset—o0

7. Measure the duty cycle of the CLOCK output using an oscilloscope
specified in Table 1. To determine if the measured duty cycle is within
the specification of the NI 5404, you must determine the measurement
error of the oscilloscope that you used to measure the duty cycle and
account for this error when comparing the measured duty cycle to the
duty cycle accuracy listed in the Specifications for the NI PXI-5404.

8. CallniFgen close () toclose the instrument I/O session, destroy the
instrument driver session and all of its properties, and release any
memory resources the driver uses. Set the following parameter:

e vi—The output value sessionHandle you obtained from the
niFgen init function

External Adjustment

This section describes the basic external adjustment steps for the NI 5404.

Overview of Calibration Constants

External calibration determines the value of several calibration constants,
which are stored in nonvolatile memory on the module. NI-FGEN uses
these constants to determine values to write to the hardware to compensate
the output. Three different sets of calibration constants are determined
during external calibration: constants for the voltage controlled crystal
oscillator (VCXO) digital-to-analog converter (DAC), the GAIN DAC, and
the SYNC DAC.

VCX0 DAC

The VCXO DAC tunes the onboard VCXO. Calibrating the VCXO DAC,
therefore, calibrates the frequency accuracy of the output.

GAIN DAC

Calibrating the GAIN DAC calibrates the amplitude accuracy and the
amplitude passband flatness of the SINE out. Because the characteristics of
the output channel vary over the frequency range of the module, the
GAIN DAC must be calibrated over several frequencies.
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SYNC DAC

The SYNC DAC adjusts the CLOCK out duty cycle. Calibrating the
SYNC DAC, therefore, calibrates the duty cycle accuracy of the CLOCK
out. Because the characteristics of the output channel vary over the
frequency range of the module, the SYNC DAC must be calibrated over
several frequencies.

Setting Up and Configuring the NI 5404

To set up and configure the NI 5404 module for adjustment, complete the
following steps:

1. Install the NI 5404 module in the PXI chassis.

2. Configure the NI 5404 module with Measurement & Automation
Explorer MAX).

3. Referring to Table 4 and Figure 1 as guides, make the appropriate
connections to measure the output for the constant you want to adjust.

Table 4. Measuring Calibration Output

Output Measurement
Applicable Adjustment Type of Measurement Connection Device
SINE out amplitude Magnitude of a sinusoidal SINE out DMM and
accuracy and passband voltage (either amplitude, power meter
flatness accuracy peak-to-peak amplitude,
or rms value)
CLOCK out Duty cycle CLOCK out Oscilloscope
duty cycle accuracy
Frequency accuracy Frequency SINE out Spectrum
analyzer

© National Instruments Corporation 17 NI PXI-5404 Calibration Procedure



Adjusting the NI 5404

Refer to Figure 2 for an overview of the adjustment process.

Initialize the Device
and Calibration Session:
nis4xx CalStart ()
nis54xx DeviceReset ()

\4

Calibrate the VCXO DAC
for Frequency Accuracy

\4

Apply Session Constants
nis4xx ApplySessionConstants ()

and Passband Flatness Accuracy

\ 4
Calibrate the GAIN DAC for
Sine Amplitude Accuracy

\ 4

Apply Session Constants
nis4xx ApplySessionConstants ()

\ 4

Calibrate the SYNC DAC
for CLOCK Out
Duty Cycle Accuracy

\4

Disable the Output and
Close the Calibration Session:
ni54xx_SetArbOutput ()
ni54xx_CalEnd ()

Figure 2. General Adjustment Procedure

To adjust the NI 5404, complete the following steps.

@ Note You may also want to refer to the External Calibration examples in LabVIEW or C,

listed in Table 2.

NI PXI-5404 Calibration Procedure
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1. Callnis4xx CalStart to open the session using the following
parameters:

device—The device number of the module you want to calibrate,
which is assigned by MAX

password—A four-character password. Enter the default
password “ARBI” if you have not already changed the password.

sessionHandle—A pointer to an integer that thereafter functions
as a handle for the calibration session

2. Callnis4xx DeviceReset to reset the module to the default state.
Set the following parameter:

sessionHandle—The handle of the calibration session for the
module

3. Complete the following steps:

a.

Adjust the VXCO DAC for frequency accuracy as described in the
Adjusting the VCXO DAC for Frequency Accuracy section.

Call nis4xx_ApplySessionConstants ().

Adjust the GAIN DAC for sine amplitude accuracy and passband
flatness accuracy as described in the Adjusting the SINE Out
Amplitude section.

Call ni54xx ApplySessionConstants ().

Adjust the CLOCK out duty cycle accuracy and passband flatness
accuracy as described in the Adjusting the CLOCK Out Duty
Cycle section.

4. Callnis4xx CalEnd to close the session using the following
parameters:

sessionHandle—A pointer to the handle of the calibration session
for the module

aCtiOﬂ—NI54XX_ABORT or NI54XX COMMIT CONSTANTS

You may either save the constants you have calculated or abort the whole
session. Aborting does not save changes to the module.

Adjusting the VCXO DAC for Frequency Accuracy

The VCXO DAC controls the frequency accuracy of the onboard VCXO.
Here you use a calibration procedure that iteratively searches for the
optimal VCXO DAC value by repeating a measurement-adjustment loop
16 times. During each step in the loop, ni54xx CalAdjust determines
the next VCXO DAC value by interrogating the measured frequency value
passed to ni54xx_CalAdjust by the previous step. During this process,
the calibration session holds an internal variable for the VCXO DAC value.

© National Instruments Corporation

19 NI PXI-5404 Calibration Procedure



This internal value is written to the VCXO DAC after you call
nis54xx CalibrateVCXO.

Refer to Figure 3 for a overview of the VCXO adjustment process.

( Module Initialization )

\ 4

Generate a Waveform
at the Desired Frequency

\ 4

Initialize VCXO Calibration

\4

p| Callni54xx CalibrateVCXO ()

\ 4

Measure Frequency

\4

Callnis4xx CalAdjust ()
with Measured Frequency

:

Have you adjusted 16 times?

Continue to SINE out
Amplitude Adjust

Figure 3. VCXO Adjustment Process
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Complete the following steps to calibrate the VCXO for frequency
accuracy:

1. Callnis54xx GenerateWaveform to generate a sine wave at the
desired frequency 1 MHz. Set the following parameters:

e sessionHandle—The handle of the calibration session for the
module

* waveType—NI54XX SINE
e amplitudeInVolts—2
¢ frequencyInHz—1000000

2. Callnis4xx SetArbOutput to enable the output. Set the following
parameters:

* sessionHandle—The handle of the calibration session for the
module

* outputState—NI54XX ENABLE

3. Callnis4axx InitializeVCXOCalibration to reset the internal
variables held by the session to begin a VCXO calibration. Set the
following parameters:

* sessionHandle—The handle of the calibration session for the
module

* type—NI54XX SET VCXO
4. Repeat steps 4a—4c 16 times to adjust the frequency accuracy:

a. Callnis4axx CalibrateVCXO to program the adjusted
VCXO DAC value to the hardware. Set the following parameters:

¢ sessionHandle—The handle of the calibration session for the
module

. type—NI54XX SET VCXO

b. Measure the frequency at the SINE out or CLOCK out on the
NI 5404.

c. Callnis4axx CalAdjust to adjust the internal VCXO DAC
value. Set the following parameters:

¢ sessionHandle—The handle of the calibration session for the
module

*  measurementMode—NI54XX SET VCXO

* actualData—A pointer to a variable that holds the desired
frequency (1000000 Hz)

* measuredData—A pointer to a variable that holds the
measured frequency (in Hz)

@ Tip If the difference between the desired and measured frequencies is smaller than the
accuracy or resolution of the measurement device, you may stop the calibration at any time.
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Adjusting the SINE Out Amplitude

Calibrating for amplitude accuracy and passband flatness accuracy at the
SINE out adjusts the value written to the GAIN DAC, which adjusts the
amplitude of the sine wave output, until the amplitude reaches the desired
value. You determine the correct value for SINE out amplitude by iterating
measurements and adjustments. The calibration session holds an internal
variable for the GAIN DAC value. The program writes this value to the
hardware when you call ni54xx_CalibrateAmplitude. When the
program calls ni54xx_CalAdjust, this variable is adjusted according to
the measured amplitude passed in. By repeatedly measuring, adjusting, and
programming the variable value to the hardware, the output amplitude
converges on the desired value. The amplitude is calibrated at several
frequencies to flatten the passband response. For the first frequency,
perform 16 adjustment iterations. For all other frequencies, perform only
eight iterations.

Figure 4 shows the programming flow for the SINE out amplitude and
passband flatness adjustments.
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< SINE Out Amplitude Adjustment )
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Figure 4. SINE Out Amplitude and Passband Flatness Adjustment Process

23 NI PXI-5404 Calibration Procedure



Because the uncompensated amplitude varies over the bandwidth of the
module, GAIN DAC calibration occurs at several frequencies to flatten the
response. Repeat the amplitude calibration for each frequency. Refer to
Table 5 for the applicable frequencies.

Table 5. SINE Out Calibration Frequencies

Index Frequency Instrument
0 50 kHz DMM
1 6 MHz Power meter
2 25 MHz Power meter
3 35 MHz Power meter
4 55 MHz Power meter
5 65 MHz Power meter
6 86 MHz Power meter
7 90 MHz Power meter
8 94 MHz Power meter
9 97 MHz Power meter
10 100 MHz Power meter
11 103 MHz Power meter
12 105 MHz Power meter

To calibrate the SINE out amplitude, complete the following steps:

1. Callnis4xx ApplySessionConstants to pass the updated
calibration constants to the underlying driver. This function ensures
that the session uses the new VXCO DAC values calculated during the
VCXO calibration.

2. Connect the SINE out to the appropriate instrument, which is
determined by the frequency in Table 5.
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3.

Repeat steps 4a through 4d(3) for each frequency listed in Table 5. For
the first iteration, use the DMM as the measurement device; for the
remaining iterations, use the power meter as the measurement device.

@ Note The 50 kHz amplitude accuracy of the DMM is better than the 50 kHz amplitude
accuracy of the power meter. To get the best passband flatness results, you either must
calibrate the power meter or use the power meter to make amplitude measurements, at
frequency indices 1-12, which are relative to the absolute amplitude measurement made
by the DMM at frequency index 0. The latter choice is preferred.

© National Instruments Corporation

To implement using the power meter to make amplitude measurements
complete the following steps:

a.

Measure the 50 kHz amplitude using the AC rms (dBm) function
of the DMM. Do not use a 50 Q terminator when using the DMM.

Subtract 6 dBm from the DMM measurement, because the power
meter has a 50 Q input impedance. The result of the subtraction is
the power level of the 50 kHz SINE out into a 50 Q load.

Measure the 50 kHz amplitude with the power meter and compare
the power result to the DMM result. If the power meter result is
higher than the DMM result, subtract the difference of the two
results from the power meter results (in dBm) for frequency
indices 1-12. If the power meter result is lower than the DMM
result, add the difference of the two results (in dBm) to the power
meter results for frequency indices 1-12.

Generate a waveform at each frequency listed in Table 5. Repeat the
following steps to generate a waveform for each frequency:

a.

Call nis4xx_GenerateWaveform. This function generates a
sine wave at the current frequency. Set the following parameters:

¢ sessionHandle—The handle of the calibration session for the
module

*  waveform Type—NI54XX SINE
¢ amplitude In Volts—2.0

* frequencies—The frequency listed in Table 5 for the current
index

Enable the output by calling ni54xx_SetArbOutput. Set the
following parameters:

e sessionHandle—The handle of the calibration session for the
module

* outputState—NI54XX ENABLE
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Call ni54xx InitializeAmplitudeCalibration to reset
the internal variables held by the session. Resetting begins an
amplitude calibration for the current frequency and sets the
internal frequency index. Set the following parameters:

¢ sessionHandle—The handle of the calibration session for the
module

e frequencyBand—The index of the current frequency value
from Table 5

For the first frequency in Table 5, repeat the following steps 16
times. For the other frequencies in Table 5, repeat the following
steps eight times:

(1) Call nis4xx CalibrateAmplitude to program the
adjusted GAIN DAC value to the hardware. Set the following
parameter:

¢ sessionHandle—The handle of the calibration session
for the module

(2) Measure the SINE out amplitude.

(3) Call nis4xx_CalAdjust to adjust the internal GAIN DAC
value based on the measured amplitude. Set the following
parameters:

*  measurementMode—NI54XX SET AMPLITUDE

¢ sessionHandle—The handle of the calibration session
for the module

e actual data—A pointer to the variable holding the
desired peak-to-peak level (2.0 V)

* measured amplitude—A pointer to a variable holding
the measured peak-to-peak level at the SINE out
connector (assume a 50 Q load)
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Adjusting the CLOCK Out Duty Cycle

Refer to Figure 5 for an overview of the duty cycle adjustment process.

< SINE Out Amplitude Adjustment )

\4

Call

nis54xx ApplySessionConstants ()

\4

Generate a W

Current Frequency

aveform at the

A

\4

Initialize a Duty Cycle Calibration
at the Current Frequency

\4

Set the SYNC DAC to a Range

of Values; Measure the

Duty Cycle for Each DAC Value

\4

Callnis4xx CalAdjust
with all of the SYNC DAC Values
and Corresponding Measurements

:

Have you

performed adjustments

for every frequency?

< Close the Calibration Session by )

Calling ni54xx_CalEnd

Figure 5. Duty Cycle Adjustment Process

The following procedure determines the characteristics of the SYNC DAC.
The SYNC DAC determines the duty cycle of the CLOCK out. The
program writes several values to the SYNC DAC and measures the duty
cycle of the CLOCK out for each of these values.
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The program then passes the SYNC DAC values and measurements of the
resulting duty cycles to ni54xx CalAdjust.

The duty cycle of an uncalibrated module depends on the frequency of the
CLOCK out. The calibration procedure determines SYNC DAC values that
compensate for the frequency dependency of the duty cycle.

For each frequency, initiate a generation at that frequency. Pass the
zero-based index to the ni54xx_InitializeDutyCycleCalibration
function.

Table 6. SYNC DAC Frequencies

Number of
Index Frequency SYNC DAC Values Measurements
0 50 kHz 60, 73, 86,99, 112, 125, 138, 151, 164, 177 10
1 15 MHz 60, 73, 86,99, 112, 125, 138, 151, 164, 177 10
2 30 MHz 60,71, 82,93, 104, 115, 126, 137, 148, 159 10
3 45 MHz 70,79, 88,97, 106, 115, 124, 133, 142, 151 10
4 60 MHz 75,81, 87,93,99, 105, 111, 117, 123, 129 10
5 75 MHz 75,81, 87,93,99, 105, 111, 117, 123, 129 10
6 90 MHz 80, 84, 88,92, 96, 100, 104, 108, 112, 116 10
7 105 MHz 70,73,76,79, 82, 85, 88, 91, 94, 97 10

To calibrate and adjust the duty cycle of the CLOCK out, complete the
following steps:

1. Callnis4xx ApplySessionConstants to instruct the driver to use
data from previous calibration steps of the session. This function
ensures that the driver uses the values calculated during the VCXO and
SINE out amplitude calibrations. Set the following parameter:

¢ sessionHandle—The handle of the calibration session for the
module

2. Connect the CLOCK out to an oscilloscope.
Set the termination of the oscilloscope listed in Table 1 to 50 Q.
Repeat the following steps for each frequency index listed in Table 6:

a. Callnis4xx GenerateWaveform to generate a sine wave at a
frequency listed in Table 6. Set the following parameters:

¢ sessionHandle—The handle of the calibration session for the
module
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* waveformType—NIS54XX SINE
e amplitudeInVolts—2 .0

e frequencyInHz—The frequency listed in Table 6 for the
current index

Enable the output by calling ni54xx_SetArbOutput. Set the
following parameters:

* sessionHandle—The handle of the calibration session for the
module

* outputState—NI54XX ENABLE

Call ni54xx InitializeDutyCycleCalibration to reset
the internal variable held by the session to begin a duty cycle
calibration for the present frequency. Set the following
parameters:

¢ sessionHandle—The handle of the calibration session for the
module

* frequencyBand—An integer, shown in Table 6, representing
the index of the frequency for the calibration being performed

*  NumberOfMeasurements—The number of duty cycle
measurements taken and passed into the
ni54xx_CalAdjust () function

For each SYNC DAC value in Table 6 for the frequency index,
complete the following steps:

(1) Call nis4axx_SetSYNCDAC to program the SYNC DAC.
Set the following parameters:

e sessionHandle—The handle of the calibration session
for the module

* DACValue—One of the SYNC DAC values in Table 6
for the current frequency index

(2) Measure the duty cycle clock at the CLOCK out.

Call nis4xx CalAdjust to pass the SYNC DAC values set and
the resulting duty cycle measurements to CalAdjust. Set the
following parameters:

* sessionHandle—The handle of the calibration session for the
module

*  measurementMode—NI54XX SET DUTY CYCLE

* actualData—An array of SYNC DAC values, as shown in
Table 6

* measuredData—An array of measured duty cycles for each
SYNC DAC value. Each value should represent the duty
cycle high, as a percentage.
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Closing the Calibration Session

If a function returns an error, call ni54xx_CalEnd to abort and close the
session. Set the following parameters:

¢ sessionHandle—The handle of the calibration session for the module
e action—NI54XX ABORT

If you do not receive an error, call ni54xx_CalEnd to save the new
constants. Set the following parameters:

¢ sessionHandle—The handle of the calibration session for the module

. action—N1I 54XX COMMIT CONSTANTS

Calibration Function Reference

This section provides detailed descriptions of NI 5404 calibration and
constant functions that support signal source performance. The NI 54XX
API provides access to the niarbcal.d11 and can be used to write
calibration procedures for any NI 5404 module.

@ Note All functions return signed, 32-bit integers corresponding to the status of the
operation.
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ni54xx_CalStart

Function Prototype

__declspec(dllexport) long _ stdcall
niS4xx CalStart (shortdevice,

char *password,
unsigned long *sessionHandle) ;
Purpose
Initiates a calibration session for the specified module.
Parameters
Name Description
device A number corresponding to the DAQ device number of the
module to be calibrated.
password The external adjustment password. This password must point
to a buffer of characters at least four characters long.
sessionHandle A pointer to the handle of the calibration session used in most
calibration functions.
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ni54xx_CalAdjust

Function Prototype
__declspec(dllexport) long stdcall
nis4xx CalAdjust (unsigned long sessionHandle,
unsigned long measurementMode,

double *actualData,
double *measuredData) ;
Purpose
Adjusts the specified calibration constant based on the values of the measured and actual data.
Parameters
Name Description
sessionHandle The handle of the calibration session for the module, created
by calling ni54xx CalStart.
measurementMode The calibration constant(s) being adjusted—one of the
constants starting with NI54XX SET.
actualData An array of doubles, a pointer to one double, or NULL,
depending on the measurementMode parameter.
measuredData An array of doubles, a pointer to one double, or NULL,
depending on the measurementMode parameter.
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niS4xx_CalEnd

Function Prototype
__declspec(dllexport) long _ stdcall
niS4xx CalEnd (unsigned long *sessionHandle,
unsigned long action) ;

Purpose
Closes the calibration session and either commits or discards the new constants that have been
calculated.
Parameters
Name Description
sessionHandle A pointer to the handle of the calibration session for the
module; created by calling ni5s4xx CalStart.
action NI54XX_ ABORT or NI54XX_COMMIT CONSTANTS. Using
abort avoids storing the newly calculated calibration
constants in the onboard EEPROM.
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ni54xx_CalFetchDate

Function Prototype

__declspec(dllexport) long _ stdcall
nis4xx CalFetchDate (unsigned long device,

long area,
long *month,
long *day,
long *year) ;

Purpose

Retrieves the date of the last calibration, either from the internal (self-calibration) or external
(manual calibration) area.

Parameters
Name Description
device A number corresponding to the DAQ device number of the
module to be calibrated.
area NI54XX EXTERNAL.
month A pointer to a long integer that receives the month value.
day A pointer to a long integer that receives the date value.
year A pointer to a long integer that receives the year value.
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ni54xx_CalFetchCount

Function Prototype
__declspec(dllexport) long _ stdcall
niS4xx CalFetchCount (unsigned long device,
long area,
long *count) ;

Purpose

Retrieves the number of times the module has been calibrated, either internally
(self-calibration) or externally (manual calibration).

Parameters
Name Description
device A number corresponding to the DAQ device number of the
module to be calibrated.
area NI54XX EXTERNAL.
count A pointer to a long integer that receives the count value.

© National Instruments Corporation 35 NI PXI-5404 Calibration Procedure



ni54xx_CalFetchMiscinfo

Function Prototype

__declspec(dllexport)

long _ stdcall

nis4xx CalFetchMiscInfo (unsigned long device,

char *miscInfo) ;
Purpose
Retrieves four bytes of data from the external adjustment miscellaneous data area.
Parameters
Name Description
device A number corresponding to the DAQ device number of the
module to be calibrated.
miscInfo A character pointer to a buffer that is at least four bytes long.
You should allocate this buffer.

NI PXI-5404 Calibration Procedure
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ni54xx_CalStoreMiscinfo

Function Prototype

__declspec(dllexport)

long _ stdcall

niS4xx CalStoreMiscInfo (unsigned long device,

char *miscInfo) ;
Purpose
Stores four bytes of data in the external adjustment miscellaneous data area.
Parameters
Name Description
device A number corresponding to the DAQ device number of the
module to be calibrated.
miscInfo A character pointer to a buffer that is at least four bytes long.
You should allocate this buffer.

© National Instruments Corporation
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ni54xx_CalChangePassword

Function Prototype
__declspec(dllexport) long _ stdcall

nis4xx CalChangePassword (unsigned long device,
char *oldPassword,
char *newPassword) ;
Purpose
Changes the password.
Parameters
Name Description
device A number corresponding to the DAQ device number of the
module to be calibrated.
oldPassword The current password.
newPassword The new password that replaces the current password.
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ni54xx_DeviceReset

Function Prototype

__declspec(dllexport) long _ stdcall
niS4xx DeviceReset (unsigned long sessionHandle) ;

Purpose
Resets the NI 54XX module and puts it in a default reset state.

Parameter

Name Description

sessionHandle The handle of the calibration session for the module; created
by calling nis4xx CalStart.
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ni54xx_SetArbQutput

Function Prototype
__declspec(dllexport) long _ stdcall
nis4xx SetArbOutput (unsigned long sessionHandle,
unsigned long outputState) ;

Purpose
Enables or disables the output of the module.
Parameters
Name Description
sessionHandle The handle of the calibration session for the module; created
by calling ni54xx CalStart.
outputState Indicates whether to enable or disable the
output—NI54XX ENABLE or NI54XX DISABLE.
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niS4xx_GenerateWaveform

Function Prototype
__declspec(dllexport) long _ stdcall
niS4xx GenerateWaveform(unsigned long sessionHandle,
unsigned long waveType,

double amplitudeInvVolts,
double frequencyInHz) ;
Purpose
Causes the module to output a sine wave with a specified amplitude and frequency.
Parameters
Name Description
sessionHandle The handle of the calibration session for the module; created
by calling nis4xx CalStart.
waveType The type of waveform to generate—NI54XX SINE.
amplitudeInVolts The peak-to-peak amplitude of the waveform (in volts); this
is the amplitude into a terminated (50 ) load.
frequencyInHz The frequency of the waveform (in Hz); ignored for DC.
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niS4xx_InitializeVCX0Calibration

Function Prototype

__declspec(dllexport)

long _ stdcall

nis4xx InitializeVCXOCalibration (unsigned long sessionHandle,

Purpose

unsigned long type);

The VCXO is calibrated iteratively. Call this function before calibrating the VCXO because
it sets many internal variables to appropriate values for the VCXO calibration.

Parameters
Name Description
sessionHandle The handle of the calibration session for the module; created
by calling ni54xx CalStart.
type The type of VCXO calibration—NI54XX SET VCXO.
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ni54xx_CalibrateVCXO0

Function Prototype
__declspec(dllexport) long _ stdcall
niS4xx CalibrateVCXO (unsigned long sessionHandle,
unsigned long type);

Purpose
Recalibrates the VCXO with the current test value. Use this function during calibration to
iteratively converge on the best value. A new value is calculated, then this function is called
to set the VCXO, then the output is measured, and then a new value is calculated, and so on.

Parameters
Name Description
sessionHandle The handle of the calibration session for the module;
created by calling ni54xx CalStart.
type The type of VCXO calibration to be
done—NT54XX_SET_ VCXO.
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ni54xx_CalGetLastCalibrationTemperature

Function Prototype

__declspec(dllexport) long _ stdcall
nisS4xx CalGetLastCalibrationTemperature (unsigned long device,

int area,
doublex* temperature) ;
Purpose
Retrieves the temperature at which the module was last calibrated.
Parameters
Name Description
device A number corresponding to the DAQ device number of the
module.
area NI54XX EXTERNAL.
temperature A pointer to a double that receives the temperature value
in °C.
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ni54xx_ApplySessionConstants

Function Prototype

__declspec(dllexport) long _ stdcall
nisS4xx ApplySessionConstants (unsigned long sessionHandle) ;

Purpose

During calibration, the session holds an internal set of calibration constants. These constants
may have been updated based on calibration steps performed during the session. This function
commits the session constants to the underlying driver so that the module is calibrated
according to the newly updated constants for the remainder of the session. This function
does not store the updated constants in the onboard EEPROM. Calling the function
ni54xx_CalEnd stores the updated constants in the onboard EEPROM.

Parameters
Name Description
sessionHandle A handle to the calibration session for the module; created by
calling ni54xx CalStart.
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ni54xx_InitializeAmplitudeCalibration

Function Prototype

__declspec(dllexport) long _ stdcall
nisS4xx InitializeAmplitudeCalibration (unsigned long
sessionHandle, unsigned long frequencyBand) ;

Purpose

The SINE out amplitude of the NI 5404 is calibrated iteratively. Call this function before
calibrating the sine amplitude because it sets many internal variables to appropriate values for
the calibration.

Parameters
Name Description
sessionHandle A handle to the calibration session for the module; created by
calling nis4xx CalStart.
frequencyBand An integer representing the index of the frequency band
under which this calibration is being performed.
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nid54xx_CalibrateAmplitude

Function Prototype

__declspec(dllexport) long _ stdcall
niS4xx CalibrateAmplitude (unsigned long sessionHandle) ;

Purpose
Returns the sine amplitude with the current test value. Use this function during calibration to
iteratively converge on the best value. A new value is calculated, then output is measured, then
a new value is calculated, and so on.

Parameters
Name Description
sessionHandle A handle to the calibration session for the module; created by
calling ni54xx CalStart.
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ni54xx_InitializeDutyCycleCalibration

Function Prototype

__declspec(dllexport) long _ stdcall
nisS4xx InitializeDutyCycleCalibration (unsigned long
sessionHandle,
unsigned long frequencyBand,
unsigned long numberOfMeasurements) ;

Purpose

Call this function before calibrating the duty cycle of the CLOCK out because it sets many
internal variables to appropriate values for the calibration.

Parameters
Name Description
sessionHandle A handle to the calibration session for the module; created by
calling nis4xx CalStart.
frequencyBand An integer representing the index of the frequency band

under which this calibration is being performed.

numberOfMeasurements The number of duty cycle measurements you pass into the
ni54xx_CalAdjust () function.
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niS4xx_SetSYNCDAC

Function Prototype

__declspec(dllexport) long _ stdcall
niS4xx SetSYNCDAC (unsigned long sessionHandle,
unsigned long DACValue) ;

Purpose

Sets the SYNC calibration DAC to the specified value. This value affects the duty cycle of the
signal at the CLOCK out and is used during a duty cycle calibration.

Parameters
Name Description
sessionHandle A handle to the calibration session for the module; created by
calling ni54xx CalStart.
DACValue The integer value to write to the SYNC DAC—ranges from
0 to 255.
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Technical Support Resources

NI Web Support

National Instruments Web support is your first stop for help in solving
installation, configuration, and application problems and questions. Online
problem-solving and diagnostic resources include frequently asked
questions, knowledge bases, product-specific troubleshooting wizards,
manuals, drivers, software updates, and more. Web support is available
through the Technical Support section of ni . com.

Worldwide Support

National Instruments has offices located around the world to help address
your support needs. You can access our branch office Web sites from the
Worldwide Offices section of ni . com. Branch office Web sites provide
up-to-date contact information, support phone numbers, e-mail addresses,
and current events.

If you have searched the technical support resources on our Web site

and still cannot find the answers you need, contact your local office or
National Instruments corporate. For telephone support in the United States,
dial 512 795 8248. For telephone support outside the United States, contact
your local branch office:

Australia 03 9879 5166, Austria 0662 45 79 90 0, Belgium 02 757 00 20,
Brazil 55 11 3262 3599, Canada (Calgary) 403 274 9391,

Canada (Montreal) 514 288 5722, Canada (Ottawa) 613 233 5949,
Canada (Québec) 514 694 8521, Canada (Toronto) 905 785 0085,
China 86 21 6555 7838, Czech Republic 02 2423 5774,

Denmark 45 76 26 00, Finland 09 725 725 11, France 01 48 14 24 24,
Germany 089 741 31 30, Greece 01 42 96 427, Hong Kong 2645 3186,
India 91 80 4190000, Israel 03 6393737, Italy 02 413091,

Japan 03 5472 2970, Korea 02 3451 3400, Malaysia 603 9596711,
Mexico 001 800 010 0793, Netherlands 0348 433466,

New Zealand 09 914 0488, Norway 32 27 73 00, Poland 22 3390 150,
Portugal 210 311 210, Russia 095 238 7139, Singapore 65 6 226 5886,
Slovenia 3 425 4200, South Africa 11 805 8197, Spain 91 640 0085,
Sweden 08 587 895 00, Switzerland 056 200 51 51,

Taiwan 02 2528 7227, United Kingdom 01635 523545
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